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ongratulations on purchasing your Virtual CD Server  from Academy Computer Services, Inc. This
system takes up a small amount of space, but replaces millions of pages of text. Gigabytes of
information are less than a second away. Your new server system features:

♦  High Speed CD–ROM drive drives fully compatible with ISO 9660
♦  CDServ CPU with 10Base-T Ethernet and RG-58 connections for network access.
♦  External SCSI port for future expansion.
♦  Up to 250 users.
♦  Tower enclosure with ample power for all drives and cooling fans for long drive life.

WARNING: Changes or modifications to this unit not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment.

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to
radio communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his own expense.

This manual explains how to install your new CD Serv 7. You will need to:

1. Unpack and check the shipment.

2. Connect the unit to the network.

3. Make CDs available to workstations.

Copyright  © 2000 by Academy Computer Services, Inc.. All rights reserved. No part of this work may
be reproduced or transmitted in any form or by any means, electronic or mechanical, including
photocopying, recording, or by any information storage or retrieval system, without the prior written
permission of the copyright owner.

C
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Getting Started

System Prerequisites
You will need the following network components:

♦  Windows 3x/95/98/NT, DOS, Apple Macintosh , UNIX , OS/2 Warp , or Internet/Intranet network using
10Base-TX or RG-58 10Base2.

♦  TCP/IP and NetBEUI enabled on the workstation that will administrate the CD Serv 7
♦  An Internet web browser loaded on the administration workstation.
♦  Ethernet patch cable or BNC coaxial cable to attach the CD Serv 7 to the network.

Unpacking the Box
Carefully unpack your shipping box:

WARNING: Server units can weigh as much as 30 pounds and should be lifted by two individuals.
Observe the practice of bending the knees, not the back. Be certain both people have a firm grasp
on the unit itself, not just the plastic wrap or other packing materials. Such materials will slide over
the component and could cause the unit to drop. Dropping the tower will result in equipment
damage and possible personal injury.

Check to see that the shipment is complete.

CD Serv 7
Large Box:
CD Serv 7
This Installation Guide
Accessory Bag:
Black Power Cord
Category 5 Ethernet Patch Cable w/
RJ45
      connector
Floppy disks: "CD-Serv Manager"

Figure 1, Package Contents

Place your server on a sturdy, flat surface. Academy recommends placement off the floor away from possible
dust contamination. If your package is incomplete or irregular in any way, please contact Academy without
delay at 800–385–6442.
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Physical Connection
1. Insert the Category 5 Ethernet patch cable into the RJ-45 connector at the rear of the CD Serv 7.

Insert the other end into a network hub.
2. Connect the power cable to the unit and plug it into the power strip or outlet. Use of a surge

protector is strongly recommended for long system life.
3. Turn on the CD Serv 7. The switch is located at the lower front of the unit.

LED Indicators
The CD Serv 7 has 4 LED indicator lights on the front. The CPU has Link, Fault, and Power LEDs. There is
a Power LED for the entire CD Serv 7. These lights give information about the operation status of the unit.

There are three steps to the system POST (Power On Self Test).

1. Just after the unit is turned on all three CPU LED indicators will light for about 1 second. This indicates
that all LEDs as correctly functioning.

2. The Power LED will remain lit through the network initialization process.

3. The Link and Fault lights will flash as the system examines the Flash-ROM.

For further information about the CPU LEDs please refer to: Error! Reference source not found..

Connecting to the Network

System Defaults
When a CD Serv 7 is connected to the network the system will configure itself to use the following defaults.

♦  The CD Serv 7 name is CD<default Ethernet address>. The default Ethernet address is
unique to each unit and cannot be changed.

♦  The CD Serv 7 will poll the network to locate DHCP/BOOP/RARP servers and acquire an IP address
through one of these servers. If no such server exists ion the network the default IP address will be
192.168.1.1.

♦  The CD Serv 7 Domain/workgroup name is WORKGROUP

♦  The CD Serv 7 administration username/password is Admin/cdserv

♦  The CD Ser 7 CD-ROM drives are shared on the network using the name Share0, Share1,
Share2, etc. There is no password security for these shares.
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Initial Setup
A valid TCP/IP address must be established for administrative access of the CD Serv 7. There are two
methods for doing this:

♦  CD Serv Manager software.

♦  Change the IP Address of the Workstation

CD Serv 7 Manager
This utility requires Windows 3x/95/98.

Install the program
1. Place the CD Serv 7 Manager disk into the floppy drive.

2. Click on Start and Run.

3. Type A:\setup.

4. Click on OK.

5. Follow the screen prompts to install the management software on the PC.

Configure the CD Serv 7 IP Address
1. Select the CD Serv Manager Utility from the Program menu.

2. The program will automatically browse the network to locate the CD Serv 7. An icon or minimized
window will list every CD Serv 7 located.

2.1. If no CD Serv 7 is discovered, use the  Discover CD Servs option of the Actions menu. Or click
on the Discover CD Servs icon (first button on the left).

3. Enlarge the CD Serv 7 window.

4. System modifications are only possible in Superuser Mode. This is a password protected security level for
Administrators.  Enter Superuser Mode by clicking on the Superuser icon (a shield/badge). Or by
selecting the Superuser option from the View menu.

5. Enter the administration password. The default password is cdserv.

6. Select the Server Parameters from the Configure menu.

6.1. This window can be used to change the unit name, Workgroup name, IP Address and Subnet
Mask.

6.2. Click on OK when done.

7. The CD Serv 7 must be rebooted for these changes to take effect. When prompted click on OK to
reboot the unit.
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Change the IP Address of the Workstation
The CD Serv 7 uses the default IP address of 192.168.1.1, with a Subnet Mask of 255.255.255.0. By changing
the IP Address of the administrator workstation to be in the same Subnet, and IP range the CD Serv 7 may
be accessed via a web browser.

Load the TCP/IP protocol
The TCP/IP protocol must be installed on the administrator's workstation.

1. Open the Windows Control Panel. Double-click on the Network icon.

OR:

2. Right-click on the Network Neighborhood desktop icon, and select the Properties option.

3. If the TCP/IP protocol is listed no further action is needed. If it is not listed click on the Add button.

4. Highlight the Protocol option, and click on the Add button.

5. Select Microsoft from the Manufacturers list. Select TCP/IP from the Network protocol list. Click on
the OK button.

6. Follow the screen prompts if Windows requests the Windows 95/98/NT CD-ROM. Reboot the
computer when prompted.

Modify the IP Address of the workstation
The TCP/IP address must be in the same range as the CD Serv 7

1. After the PC has rebooted open the Windows Control Panel. Double-click on the Network icon.

OR:

2. Right-click on the Network Neighborhood desktop icon, and select the Properties option.

3. Select TCP/IP and click on the Properties button.

4. Select the IP Address tab.

5. If the radio button next to Specify an IP address is selected, the IP address field lists an address of
192.168.1.x (where x is a number from 2 to 254), and the Subnet Mask is 255.255.255.0 no further action
is needed.

5.1. If the radio button next to "Obtain an IP address automatically" is selected. Click on the radio
button next to Specify an IP address. Enter the IP address 192.168.1.x (where x is a number from 2
to 254), and the Subnet Mask of 255.255.255.0

6. Click on OK to return to the Network properties window.

7. Click on OK. Restart the computer when prompted. As the workstation restarts the new parameters will
be in effect.
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Modify the server parameters
The default IP address of the CD Serv 7 is 192.168.1.1. By following the previous steps the workstation and
the CD Serv 7 are now in the same "Intranet". To access the Administrator's web utility of the CD Serv 7,
and make any desired IP address modifications to the CD Serv 7:

1. Open a web browser on the workstation.

2. The URL of the CD Serv 7 Administration main web page is http://192.168.1.1/admin. By default, the
username/password for Administrator access is admin/cdserv.

3. To modify the server parameters (server name, domain, IP address, etc) click on the Server Parameters
link. Click on the Modify Parameters button. After any/all modifications are made click on the Save
button at the bottom of the screen.

4. To change the Administration password click on the Server Password link. After any modifications are
made click on the Save button at the bottom of the page.

5. The CD Serv 7 must be rebooted for any of these new server parameters take effect.

5.1. Click on the Shutdown link.

5.2. Click on "Yes, continue with shutdown".

5.3. Power off the CD Serv 7 when prompted.

After all TCP/IP modifications are made to the CD Serv 7, the original IP settings of the workstation
may be restored.
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System Management
Administration of the CD Serv 7 is done through a web browser. The default URL of CD Serv 7
Administration page is http://192.168.1.1/admin. The Administration page uses frames, and links to the
following administration features: CD-ROM List, Server Parameters, Drive Parameters, Virtual Volume,
Security, User Level Configuration, HTTP Customization, Server Password, Statistics, Reset, Shutdown,
Firmware Upgrade, Help.

CD-ROM List
The CD-ROM List displays a table of all currently available CDs and any Virtual Volumes.

Server Parameters
The current server system parameters (server name, doamin name, IP address, etc.) are displayed on this
page. To modify any of these parameters click on the Modify Parameters button. After any/all
modifications are made click on the Save button at the bottom of the screen

Drive Parameters
The current drive parameters (share name, volume name, etc.) are displayed on this page. To modify any of
these parameters select a drive from the drop down list and click on the Modify Parameters button. The
Share Name may be changed, a password may be entered to provide share level security to the drive, or a
limit may be placed on the total number of users who can access the drive. After any/all modifications are
made click on the Save button at the bottom of the screen.

Virtual Volume
The Virtual Share provides a method for all CDs to be accessed via a single network share. The default name
of the Virtual Share is ROOT. To change this default name, or to disable the Virtual Share select this link.
After any/all modifications are made click on the Save button at the bottom of the screen.

Security
Share Level
The system default. Share Level Security limits access to a volume by requiring a password for a specific
share. There are no default passwords for shares.

User Level
A user must be stored in the CD Serv 7 database of users to be allowed access to a volume.

Drive Level
Access to specific CD-ROM drives is restricted based on users listed on the CD Serv 7 database.

User Level Configuration
The database of users used by User Level and Drive Level security.

HTTP Customization
The CD Serv 7 can be customized to act as a Web Server by assigning any HTML file stored on the unit as
the home page of the CD Serv 7.
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Up to three HTML files from a single CD-ROM drive can be selected as HTML files. When the Serv 7 is
accessed as a Web Server the files are searched, in order, and the first viable HTML page is displaced inthe
user's web browser.

Server Password
The Administration security password may be modified on this page. After any/all modifications are made
click on the Save button at the bottom of the screen.

Statistics
Statistics on system usage by Windows, HTTP, NFS, and AppleTalk users is available on this page.

Reset
The links on this page will cause the CD Serv 7 to reboot.

Shutdown
The links on this page will cause the CD Serv 7 to shutdown.

Firmware Upgrade
Select this page when a firmware upgrade is required.

Help
Explanations of each page and its functions are available on this page.
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User Access
All CDs can be accessed via a single drive mapping. The CD Serv 7 default volume of ROOT (a Virtual
Share) may be used for this mapping. All CDs are available as subdirectories of this volume.

Windows95/98/NT Peer Networks
Workstations must have the NetBEUI or TCP/IP protocol loaded.

1. Double click on Network Neighborhood.

2. Double click on the CD Serv 7.

3. Highlight the ROOT volume.

4. Select Map Network Drive from the File menu. Select a drive letter to use for the mapping. Place a check
in the box labeled "Reconnect at logon".

5. Click on OK. A new window will open, showing the data accessible through the mapped drive. The
mapping process is now complete. Close all windows.

Windows 3x/Windows for Workgroups
Workstations must have the NetBEUI or TCP/IP protocol loaded.

1. Start the File Manager.

2. Open the Disk menu and select the Connect Network Drive option.

3. A pop-up window will open. In the Show Shared Directories frame double click on the workgroup that
contains the CD Serv 7. If the workgroup does not appear, click on the browse button.

4. Double click on the CD Serv 7. Each shared volume will appear in the Share Directories frame.

6. Highlight the ROOT volume and click on the OK button. The mapping process is now complete. Close
all windows.

Windows NT Client/Server
Workstations must have the TCP/IP protocol loaded.

1. Double click on Network Neighborhood.

2. Double click on the CD Serv 7.

3. Highlight the ROOT volume.

4. Select Map Network Drive from the File menu. Select a drive letter to use for the mapping. Place a check
in the box labeled "Reconnect at logon".

5. Click on OK. A new window will open, showing the data accessible through the mapped drive. The
mapping process is now complete. Close all windows.
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Apple Macintosh
The Chooser is used to mount/access CDs.

1. Click on the Apple menu.

2. Select Chooser.
3. If AppleTalk is not currently active, click on the radio button to make it active.

4. Connect to the server.

4.1. Select AppleShare. All Mac servers will appear in the right window.

4.1.1. Highlight the CD Serv 7. Click on OK
4.2. Select the Volume to mount. Click on OK

4.2.1. By selecting the ROOT volume, all CDs will be accessible.

4.2.2. All true Mac (HFS format) CD/Imaged CDs will also appear as separate volumes. If an
HFS CD is selected it will be mounted directly on the desktop.

4.3. A connection log in window will open.

4.4. Click on Connect
4.5. Select the CD(s) you want to mount and click on OK
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Technical Specifications

Protocols Protocols TCP/IP, SMB, NFS, HTTP, AFP

File Formats ISO 9660, HSF, Multisession, ISO 9660 with Rock
Ridge, Apple HFS

TCP/IP Suite RARP, BOOTP, DHCP, WINS

Network Interface 10Base-2 (BNC), 10Base-T (RJ-45)

Operating Condition Temperature 32°-104° F (0°-40°C)

Humidity 10-90% RHS

LED Codes
Stage Power LED Fault LED LAN LED
Power ON On Off Off

POST Flash Off Off

Memory Error On On Off

RTC Error Off On Off

Network Error Flash On Off

CMD IDE Error Off On On

MFG Test Flash Flash Off

Set Default Flash On Flash

Firmware Upgrade Flash Off Flash

Ready On Off Flash

System Halt/Diag
Error/MFG Error

On On On
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Support Numbers

Contacting Academy Computer Services
Academy Computer Services: 800–385–6442, Fax: 781-279-4262

Academy e-mail: tech@academycomputerservice.com

Warranty and Disclaimer Information
Specifications subject to change without notice. All trademarks the property of their respective companies.
Warranty: One-year parts and labor from date of purchase. This warranty is in lieu of all other express
warranties which now or hereafter might otherwise arise with respect to this product, implied warranties,
including those of merchantability, fitness for a particular purpose and non–infringement shall (A) have no
greater duration that 1 year from the date of purchase (B) terminate automatically at the expiration of such
period and (C) to the extent permitted by law be excluded. In the event this product becomes defective
during the warranty period, the purchaser’s exclusive remedy shall be repair. Incidental or consequential
damages, including without limitation loss of data or inaccurate retrieval of data, arising from breach of any
express or implied warranty are not the responsibility of Academy Computer Services, Inc. and, to the extent
permitted by law, are hereby excluded both for property damage, and to the extent not unconscionable, for
personal injury damage.

Options
Many installations require modifications or additions for optimal functionality. To this purpose we offer CD
changers/jukeboxes, Macintosh interfaces, OS/2 drivers, Ornetix Software for CD management in Novell or
Windows NT environments, dual channel SCSI cards for multiple towers, multiplexers, Virtual CD Towers
using hard disks and other options too numerous to list. We have extensive experience with large and custom
installations. Please call 800-385-6442 for a tailored quotation.

Recommendation for Further Study
Elshami, Ahmed M. Networking CD-ROMs. American Library Association. Chicago. IL. 1996. 800-545-
2433 press 7 to order.
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